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Introducing 3D-Win

3D-Win is a powerful stand-alone application for viewing three-dimensional AutoCAD drawings and 
Mechanical Desktop models. It is especially designed for dual-screen CAD solutions, where you can 
work with AutoCAD on one screen and 3D-Win on the other.

With 3D-Win you can ...
· load an AutoCAD model very quickly and display it as a wireframe or with flat or gouraud shading,
· automatically transfer changes to AutoCAD models (Hot Link feature),
· use the mouse to dynamically change the 3D view of your model and export the view back to 

AutoCAD,
· change material properties of your objects,
· select objects by clicking anywhere on their surfaces, and export 3D-Win’s selection set to AutoCAD,
· easily create animations with the mouse,
· define a Walk-around or a Walk-through as animation,
· replay and save your animation or create AVI files from it.

{button ,AL(`topic_howto',1,"")}    Instructions



Getting started

1 Click the 3D-Win icon in the Diamond program group to start 3D-Win. If AutoCAD is not running, the 
Get Model command and all other commands of the AutoCAD pull-down menu are disabled.

2 Start AutoCAD. When AutoCAD is running, these commands are now enabled.
3 Load a drawing in AutoCAD (preferably 3D, for example, SEXTANT.DWG),. or create a drawing 

yourself (for example, command _sphere).
4 Switch to 3D-Win.
5 Execute the Get Model command to transfer the model data from AutoCAD to 3D-Win.
6 Activate the Gouraud mode (see Gouraud command) to see the model gouraud-shaded.
7 Hold down the right mouse button and move the mouse to change the view of the model 

dynamically.

{button ,AL(`topic_howto',1,"")}    Related topics



3D-Win’s window components

Figure 1 shows the 3D-Win screen. 

The screen consists of the following components:
Menu bar        Toolbars        Scroll bars        Status bar

Notes
· Click on a window component in Figure1 for more help. 

Figure 1        3D-Win in action



Commands 

File menu
Edit menu
Mode menu
View menu
AutoCAD menu
Animation menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new model..
Open Opens an existing model.
Close Closes the active model.
Save Saves the active model.
Save As Saves the active model to a specified file name.
Export Materials Saves the current material library into a material library file.
Import Materials Merges materials from a material library file into current material 

library.
Delete all 
Materials

Deletes all materials in the current material library.

Preferences Configures 3D-Win.
Exit Exits 3D-Win.

New command (File menu)

Use this command to create a new model in 3D-Win.

You can open an existing model with the Open command.

Shortcuts
Keys: Ctrl+N
Toolbar:

Open command (File menu)

Use this command to open an existing model. You can have several models open at once. Use the 
Window menu to switch between the various open models. See Window 1, 2, ... command.

You can create new models with the New command.

Shortcuts
Keys: Ctrl+O
Toolbar:

Close command (File menu)

Use this command to close all windows containing the active model. 3D-Win prompts you to save 
changes to your model before you close it. If you close a model without saving, you lose all changes 
made since the last time you saved it. Before closing an untitled model, 3D-Win displays the Save As 
dialog box so that you can name and save the model.



Save command (File menu)

Use this command to save the active model to its current name and directory. When you save a model 
for the first time, 3D-Win displays the Save As dialog box so you can name your model. If you want to 
change the name and directory of an existing model before you save it, choose the Save As command.

Shortcuts
Keys: Ctrl+S
Toolbar:

Save As command (File menu)

Use this command to save and name the active model. 3D-Win displays the Save As dialog box so you 
can specify a name for your model.

To save a model with its existing name and directory, use the Save command.



Export Materials command (File menu)

Use this command to save the materials of your current material library. 3D-Win displays the Save As 
dialog box so you can specify a name for your material library.

To load materials from a material library file use the Import Materials command.

{button ,AL(`topic_material',1,"")}    Related topics



Import Materials command (File menu)

Use this command to load materials from a material library file. The materials will be merged into your 
current material library.

To save the materials of your current material library use the Export Materials command. 

{button ,AL(`topic_material',1,"")}    Related topics



Delete all Materials command (File menu)

Use this command to delete all materials of your current material library.

To load materials from a material library file use the Import Materials command; to save the materials 
of your current material library use the Export Materials command. 

{button ,AL(`topic_material',1,"")}    Related topics



Preferences command (File menu)

Use this command to configure 3D-Win. In the Preferences dialog box you can modify global 
parameters.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four models you 
opened. Select the number corresponding to the model you want to open.



Exit command (File menu)

Use this command to end your 3D-Win session. You can also use the Close command on the 
application’s control menu. 3D-Win prompts you to save models with unsaved changes.

Shortcuts
Keys: ALT+F4

Edit menu commands

The Edit menu offers the following commands:

Invert Selection Inverts current selection set.
Clear Selection Clears current selection set.
Set Target Defines a new target point.
Hide Hides selected entities.
Show All Shows all hidden entities.
Layer Displays the Switch layer dialog box.
Material Assigns new material features to the selected colour.
Reset Materials Clears the material table and resets all materials to AutoCAD 

defaults. 

Invert Selection command (Edit menu)

Use this command to invert the current selection set. Bounding boxes around the selected entities 
indicate the current selection.

Shortcuts
Mouse: Hold down the Ctrl key and click with the left mouse button 

on the background of the scene. 

{button ,AL(`topic_select',1,"")}    Related topics



Clear Selection command (Edit menu)

Use this command to clear the current selection set. Bounding boxes around the selected entities 
indicate the current selection.

Note:
· This command is inactive when no entities are selected.

Shortcuts
Keys: Esc
Mouse: Click with left mouse button on the background of the scene.

{button ,AL(`topic_select',1,"")}    Related topics



Set Target command (Edit menu)

Use this command to specify the center of the selected entity as the new target point. Bounding boxes 
around the selected entities indicate the current selection.

Note:
· This command is inactive when no entities are selected.

{button ,AL(`topic_view;topic_select',1,"")}    Related topics



Hide command (Edit menu)

Use this command to hide the selected entities. To undo this command use the Show all command. 
Bounding boxes around the selected entities indicate the current selection.

Note:
· This command is inactive when no entities are selected.

{button ,AL(`topic_select',1,"")}    Related topics



Show All command (Edit menu)

Use this command to unhide all hidden entities. To hide entities use the Hide command.

Note:
· This command is inactive when there are no hidden entities.

{button ,AL(`topic_select',1,"")}    Related topics



Layer command (Edit menu)

Use this command to switch layers on or off. To toggle the status of a layer, 3D-Win displays the Switch
layer dialog box.



Material command (Edit menu)

Use this command to change the material properties of the selected entity. For defining or selecting 
your material, 3D-Win displays the Choose Material dialog box.

Notes
· The modifications apply to the material; so all entities with this material will be affected.
· This command is inactive when no entities are selected.

{button ,AL(`topic_material;topic_select',1,"")}    Related topics



Reset Materials command (Edit menu)

Use this command to reset all materials to AutoCAD default. To change material properties use the 
Material command.

{button ,AL(`topic_material',1,"")}    Related topics



Mode menu commands

The Mode menu offers the following commands:

Camera Rotates camera around target.
Target Rotates target around camera.
Twist Rotates camera around line of sight.
Distance Changes camera distance.
Zoom Changes camera focal length.
Clip Clips view volume.

Camera command (Mode menu)

Use this command to activate the Camera mode. The checkmark in front of this menu item indicates 
that the Camera mode is active.

If this mode is active...
· The scroll bars change the camera's viewing angle of the target.
· The horizontal scroll bar changes the camera's viewing angle in the XY plane relative to the X axis 

(from -180 to 180 degrees). An angle of 0 degrees corresponds to looking down the X axis toward 
the origin.

· The vertical scroll bar changes the camera's viewing angle above or below the XY plane. An angle of
90 degrees corresponds to looking down from above, and an angle of -90 degrees corresponds to 
looking up from below. An angle of 0 degrees means that the camera is in the XY plane.

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_mode',1,"")}    Related topics



Target command (Mode menu)

Use this command to activate the Target mode. A check mark in front of this menu item indicates that 
the Target mode is active.

If this mode is active...
· The scroll bars move the target around the camera.
· The horizontal scroll bar changes the target's position at an angle in the XY plane relative to the X 

axis (-180 degrees to 180 degrees). An angle of 0 degrees means you look down the X axis toward 
the origin.

· The vertical scroll bar changes the target's position at an angle above or below the XY plane. An 
angle of 90 degrees corresponds to looking down from above, and an angle of -90 corresponds to 
looking up from below. A target angle of 0 degrees means that the target is in the XY plane.

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_mode',1,"")}    Related topics



Twist command (Mode menu)

Use this command to activate the Twist mode. A checkmark in front of this menu item indicates that 
the Twist mode is active.

If this mode is active...
· The horizontal scroll bar twists or tilts the view around the line of sight. This angle measures 

counterclockwise from -180 to 180 degrees.
· The vertical scroll bar is inactive.

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_mode',1,"")}    Related topics 



Distance command (Mode menu)

Use this command to activate the    Distance mode. A checkmark in front of this menu item indicates 
that the Distance mode is active.

If this mode is active...
· The horizontal scroll bar moves the camera in or out along the line of sight relative to the target.
· The vertical scroll bar is inactive.

If you select the Distance command when the Distance mode is already active, it will reset the 
horizontal scroll bar.

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_mode',1,"")}    Related topics 



Zoom command (Mode menu)

Use this command to activate the Zoom mode. A checkmark in front of this menu item indicates that 
the Zoom mode is active.

If this mode is active...
· The horizontal scroll bar decreases or increases the focal length of the camera.
· The vertical scroll bar is inactive.

If you select the Zoom command when the Zoom mode is already active, it will reset the horizontal 
scroll bar.

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_mode',1,"")}    Related topics 



Clip command (Mode menu)

Use this command to activate the Clip mode. A check mark in front of this menu item indicates that 
this mode is active.

If this mode is activated...
· The horizontal scroll bar clips the view, hiding those portions of the drawing that are in front of the 

front clipping plane. The front clipping plane is an invisible wall that you can position between the 
camera and target, perpendicular to the line of sight. The clip ratio ranges from 0.0 (whole drawing 
hidden) to 1.0 (nothing hidden).

· The vertical scroll bar is inactive.

You can use this command to set a new target point.

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_mode',1,"")}    Related topics 



View menu commands

The View menu offers the following commands:

Wireframe Displays model in wireframe.
Flat Displays model with flat shading.
Gouraud Displays model with gouraud shading.
Rotate in Wireframe Rotates model in wireframe.
Default Lighting Uses default lighting (infinite distance white light).
Initial View Restores initial view.

Wireframe command (View menu)

Use this command to activate the Wireframe mode. A check mark in front of this menu item indicates 
that the Wireframe mode is active.

If this mode is active, the object is represented by line segments only. 

Shortcuts
Toolbar:

{button ,AL(`topic_style',1,"")}    Related topics



Flat command (View menu)

Use this command to activate the Flat shading mode. A check mark in front of this menu item indicates
the Flat mode is active.

Flat shading refers to coloring a primitive with a single, uniform color all over, rather than smoothly 
interpolating colors across the primitive (see the Gouraud command).

Shortcuts
Toolbar:

{button ,AL(`topic_style',1,"")}    Related topics



Gouraud command (View menu)

Use this command to activate the Gouraud shading mode. A checkmark in front of this menu item 
indicates that the Gouraud mode is active.

Gouraud shading refers to smoothly interpolating colors across a primitive, rather than coloring a 
primitive with a single, uniform color all over (see the Flat command).

Shortcuts
Toolbar:

{button ,AL(`topic_style',1,"")}    Related topics



Rotate in Wireframe command (View menu)

Use this command to enable or disable the Rotate in Wireframe function. A checkmark in front of this 
menu item indicates that the Rotate in Wireframe function is active.

If this function is active, the object is displayed in wireframe mode while you are changing the view...
· by moving the mouse with the right mouse button held down.
· by moving one of the scroll bars.

After you release the mouse button, the object will be displayed again in the active mode.

Note:
· Rotation in wireframe mode can be significantly faster, especially for objects represented by isolines 

in wireframe mode.

{button ,AL(`topic_style',1,"")}    Related topics



Default Lighting command (View menu)

Use this command to activate the Default Lighting mode. A checkmark in front of this menu item 
indicates that the Default Lighting mode is active.

If this mode is active, a single white spotlight illuminates the scene, except for the ambient light. The 
position of this light always corresponds to the position of the camera (a so-called helmet light).

Note:
· The Default Lighting mode is active by default if no other lighting is defined for the model (drawing).



Initial View command (View menu)

Use this command to restore the initial view of the model.

The initial view is the view which is set after loading a model from a file (see Open command) or from
AutoCAD (see Get Model command).

Shortcuts
Toolbar:

{button ,AL(`topic_view;topic_style',1,"")}    Related topics



AutoCAD menu commands

The AutoCAD menu offers the following commands:

Connect Connects AutoCAD to the current model.
Get Model Reads current AutoCAD model data.
Get View Gets AutoCAD's current view.
Export ortho. view Exports viewing parameters to AutoCAD (orthographic).
Export persp. view Exports viewing parameters to AutoCAD (perspective).
Select Turns the entities selected in 3D-Win into AutoCAD selection set.
Unselect Removes 3D-Win's selected entities from AutoCAD's selection 

set.
Add Selection Adds 3D-Win's selected entities to AutoCAD's selection set.
Get Selection Retrieves AutoCAD's current selection set.
Hot Link Hotlink to AutoCAD database.
Hot View Exports current view immediately to AutoCAD.

Connect command (AutoCAD menu)

Use this command to connect the active model to AutoCAD. 

Notes:
· You can connect only one model to AutoCAD, even if several models are open.
· If the Get Model command is enabled, the active model is already connected to AutoCAD.
· If AutoCAD is not running, the Get Model command and the Connect command are disabled.

Shortcuts
Toolbar:

Get Model command (AutoCAD menu)

Use this command to get the current model (drawing) from AutoCAD.

Important: If you have selected entities in AutoCAD, only the selected entities are read-in.

Notes:
· If AutoCAD is not running, this command is disabled.
· Enable the Hot Link function if you want to transfer all AutoCAD modifications to 3D-Win 

automatically.

Shortcuts
Toolbar:

{button ,AL(`topic_start',1,"")}    Related topics



Get View command (AutoCAD menu)

Use this command to get AutoCAD’s current view.

Note:
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

{button ,AL(`topic_view',1,"")}    Related topics



Export ortho. view command (AutoCAD menu)

Use this command to export 3D-Win’s current view to AutoCAD. In AutoCAD the parallel projection 
view will be set. To set a perspective view in AutoCAD use the Export persp. view command.

Notes:
· If AutoCAD is not running, this command is disabled.
· If you want to export 3D-Win’s view automatically to AutoCAD, enable the Hot View function.

Shortcuts
Toolbar:

{button ,AL(`topic_view',1,"")}    Related topics



Export persp. view command (AutoCAD menu)

Use this command to export 3D-Win’s current view to AutoCAD. In AutoCAD the perspective view will 
be set. To set a parallel projection view in AutoCAD use the Export ortho. view command.

Note:
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

{button ,AL(`topic_view',1,"")}    Related topics



Select command (AutoCAD menu)

Use this command to export 3D-Win’s selection set to AutoCAD. To add 3D-Win’s selected entities to 
AutoCAD’s current selection set, use the Add Selection command. To remove 3D-Win’s selected entities
from AutoCAD’s current selection set , use the Unselect command.

Notes:
· This command doesn’t work transparently, i.e. while you are executing a command in AutoCAD.
· Bounding boxes around the selected entities indicate the current selection set.
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

{button ,AL(`topic_select',1,"")}    Related topics



Unselect command (AutoCAD menu)

Use this command to remove 3D-Win’s selected entities from AutoCAD’s current selection set. To make
3D-Win’s selected entities to AutoCAD’s new current selection set, use the Select command. To add 3D-
Win’s selected entities to AutoCAD’s current selection set, use the Add Selection command.

Notes:
· This command doesn’t work transparently, i.e. while you are executing a command in AutoCAD.
· Bounding boxes around the selected entities indicate the current selection set.
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

{button ,AL(`topic_select',1,"")}    Related topics



Add Selection command (AutoCAD menu)

Use this command to add 3D-Win’s selected entities to AutoCAD’s current selection set. To make 3D-
Win’s selected entities to AutoCAD’s new current selection set, use the Select command. To remove 
3D-Win’s selected entities from AutoCAD’s current selection set, use the Unselect command.

Notes:
· This command doesn’t work transparently, i.e. while you are executing a command in AutoCAD.
· Bounding boxes around the selected entities indicate the current selection set.
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

{button ,AL(`topic_select',1,"")}    Related topics



Get Selection command (AutoCAD menu)

Use this command to retrieve AutoCAD’s current selection set.

Notes:
· Bounding boxes around the selected entities indicate the current selection set.
· If AutoCAD is not running, this command is disabled.

{button ,AL(`topic_select',1,"")}    Related topics



Hot Link command (AutoCAD menu)

Use this command to enable or disable the Hot Link function. A checkmark in front of this menu item 
indicates that the Hot Link function is active.

If this function is active, all modifactions of the AutoCAD model (drawing) will automatically be 
transferred to 3D-Win (see also: Get Model command).

Note:
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

Hot View command (AutoCAD menu)

Use this command to enable or disable the Hot View function. A checkmark in front of this menu item 
indicates that the Hot View function is active.

If this function is active, 3D-Win’s view is automatically exported to AutoCAD (see also: Export ortho. 
view command).

Note:
· If AutoCAD is not running, this command is disabled.

Shortcuts
Toolbar:

{button ,AL(`topic_view',1,"")}    Related topics



Animation menu commands

The Animation menu offers the following commands:

Open Loads animation from a TEACH file.
Save Saves current animation in a TEACH file.
Save as AVI Saves current animation as AVI file.
Walk Defines a Walk as animation.
Record Starts recording.
Pause Pauses recording.
Stop Stops recording.
Rewind Rewinds to first recorded view.
Play Plays recorded animation.
Step Forward Plays one frame of animation.

Open command (Animation menu)

Use this command to load an animation from a TEACH file.

For more information on animations, see How to create, play and save animations?.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Save command (Animation menu)

Use this command to save your current animation as a TEACH file. 3D-Win displays the Save As 
dialog box so you can name your animation.

To create an animation, see the Record command and/or the Walk command.

For more information on animations, see How to create, play and save animations?.

Note:
· This command is only active if you have recorded or defined an animation.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Save as AVI command (Animation menu)

Use this command to save your current animation as an AVI file. 3D-Win displays the Save As dialog 
box so you can name your animation. Also, you need to choose a video compressor for your AVI file

To create an animation, see the Record command and/or the Walk command.

To specify the resolution of the AVI file, use the Preferences command which displays the Preferences 
dialog box.

For more information on animations, see How to create, play and save animations?.

Notes.
· To replay your AVI file you may use, for example, Microsoft’s Media Player (mplayer.exe).
· This command is only active if you have recorded or defined an animation.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Walk command (Animation menu)

Use this command to define a Walk as animation. 3D-Win displays the Walk dialog box where you can 
define the required parameters.

For a detailed description, see How to define a Walk as animation?.

For more information on animations, see How to create, play and save animations?.

Note:
· The Walk will be your current animation, that is, your previously recorded animation will be lost.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Record command (Animation menu)

Use this command to start recording an animation. All subsequent changes of the view will be written 
into the current animation. To stop recording use the Stop command; to replay the animation use the 
Play command.

For more information on animations, see How to create, play and save animations?.

Note:
· Your previously recorded animation will be lost when executing this command.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Pause command (Animation menu)

Use this command to pause while recording an animation. To continue recording use this command 
again; to stop recording, use the Stop command.

For more information on animations, see How to create, play and save animations?.

Note:
· This command is only active when an animation is being recorded.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Stop command (Animation menu)

Use this command to stop recording an animation. To start recording use the Record command.

For more information on animations, see How to create, play and save animations?.

Note:
· This command is only active when an animation is being recorded.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Rewind command (Animation menu)

Use this command to return to the first view of the current animation.

For more information on animations, see How to create, play and save animations?.

Note:
· This command is only active if you have recorded or defined an animation.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Play command (Animation menu)

Use this command to replay the current animation.

For more information on animations, see How to create, play and save animations?.

Note:
· This command is only active if you have recorded or defined an animation.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Step Forward command (Animation menu)

Use this command to set the next view of the current animation.

For more information on animations, see How to create, play and save animations?.

Note:
· This command is only active if you have recorded or defined an animation.

Shortcuts
Toolbar:

{button ,AL(`topic_animation',1,"")}    Related topics



Window menu commands

The Window menu offers the following commands:

Toolbars Shows or hides the specified toolbar.
Status Bar Shows or hides the status bar.
New Window Opens another window for the active model.
Cascade Arranges windows so they overlap.
Tile Arranges windows as non-overlapping tiles.
Arrange Icons Arranges icons at the bottom of the window.

Toolbars command (Window menu)

Use this command to display and hide the specified Toolbar, which includes buttons for some of the 
most common commands in 3D-Win, such as File Open. A checkmark next to the menu item indicates 
that the specified Toolbar is displayed.

See Toolbar for help on using the toolbar.



Status Bar command (Window menu)

Use this command to display and hide the Status Bar. A checkmark next to the menu item indicates 
that the Status Bar is displayed.

See Status Bar for help on using the status bar.



New Window command (Window menu)

Use this command to open a new window with the same contents as the active window. You can open 
multiple model windows to display different parts or views of a model at the same time. If you change 
the contents in one window, all other windows containing the same model reflect those changes. A 
new window becomes the active window and is displayed on top of the open windows.



Cascade command (Window menu)

Use this command to arrange multiple open windows overlapped. 



Tile command (Window menu)

Use this command to arrange multiple open windows next to each other.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window. If 
there is an open model window at the bottom of the main window, then some or all of the icons may 
be hidden underneath it.



1, 2, ... command (Window menu)

3D-Win displays a list of currently open model windows at the bottom of the Window menu. A 
checkmark appears in front of the model name of the active window. Choose a model from this list to 
make its window active.



Help menu commands

The Help menu offers the following commands:

Help topics Displays the Help topics dialog box.
About 3D-Win Displays program information, version number and copyright.

Help topics command (Help menu)

Use this command to display the Help topics dialog box. From the Help topics dialog box, you can 
access step-by-step instructions for using 3D-Win and various types of reference information.

If Help is open, you can click the Help topics button whenever you want to return to the Help topics 
dialog box.

Shortcuts
Keys: F1

About 3D-Win command (Help menu)

Use this command to display the copyright notice and version number of your copy of 3D-Win.



Toolbar buttons

Figure 2 shows the toolbar buttons available in 3D-Win, divided into six toolbars. Each toolbar can be 
attached, or docked, to any side of the 3D-Win main window, or it can be floated in its own mini-frame 
window.

Figure 2        Toolbars

    

    

    

    

Note:
· Click on a tool button to get more help on the corresponding command.



Dialog boxes

3D-Win contains the following dialog boxes:

Dialog box Available by command
Preferences Preferences (File menu)
Choose Material Material (Edit menu)
Switch Layer Layer (Edit menu)
Walk Walk (Animation menu)
About 3D-Win About 3D-Win (Help menu)

Preferences dialog box

Use this dialog box to change global parameters of 3D-Win. This dialog box is available from the 
Preferences command.

Figure 3 shows the dialog box which contains the following sections:

· Dynamic Rendering Break
Defines the parameters for the dynamic rendering break, allowing you to change the view 
dynamically with the mouse, even with a large model.
· Break after <n> milliseconds

Defines the time after which the calcucation of the next view will be interrupted. Only those parts 
of the model calculated from this point will be displayed. This allows better control with the 
mouse.

· Check time when <n> vertices processed
To avoid excessive time checking, the time for rendering break is only checked for every <n> 
processed vertices of the model.

· Default setting
Click on this button to restore the default values (100 ms and 100 vertices).

· AVI File format
Defines the resolution of an AVI file (in pixel) which you can create with the Save as AVI command.

· Lighting
· Flip normal vectors if necessary

Orients the surface normals so that they are always toward the camera. The purpose of this is to 
illuminate all surfaces. Use this flag if your model has objects containing faces with mixed 
orientations.

· Background Color
3D-Win displays a Color dialog box so you can select a color for the background of the model 
window. Default is the system window color.



Figure 3        Preferences dialog box



Choose material dialog box

Use this dialog box to change the material properties of the selected entity and get a preview of the 
new material properties. If the selected entity is a block that contains more than one material, you can 
choose the desired material in the Material Preview window.

Important: The modifications apply for all entities to which the selected material has been 
assigned.

This dialog box is available from the Material command. 

Figure 4 shows the dialog box with the following sections:

· Color selection
Use this section to define the different colors of the material.
There are radio buttons for the four different color components of the material. For each color 
component you can...
· select a pre-defined color, or
· define a color by clicking in the color matrix and using the slider at the right of the color matrix to 

adjust the luminance, or
· enter values directly either for Hue/Sat/Lum or Red/Green/Blue.
The four colors that define a material are:
· Diffuse

Plays the most important role in how you perceive the color of an object. It is most intense where 
the light falls perpendicular to the surface.

· Ambient
Affects the overall color of an object. It’s most noticable where the object does not receive direct 
illumination.

· Specular
The specular color produces highlights. To control the size of the highlight use the Shininess 
section.

· Emission
When you specify an emission color, the object seems to send out light of that color (like a 
lamp).

· Material Preview
In this window you get a preview of how the material will look. As in the model window, you can 
change the view by moving the mouse with the right mouse button held down.

· Material Library
Instead of defining a material in the Colour Selection section, you can choose a material from your 
material library.

· Shininess
The shininess factor controls the size of a highlight (if a specular color is defined).

· Reset
Resets the material to the AutoCAD default.

· Add to Library
Adds your newly defined material to your material library. You can always access these materials 
quickly in the Material Library section.
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Figure 4        Choose material dialog box



Switch layer dialog box

Use this dialog box (available from the Layer command) to enable or disable layers of the model. 

The dialog box lists all drawing layers and their ON/OFF status (checkbox marked = ON). To toggle the 
status of a layer simply click on its checkbox. Watch the model window to see the effect of the 
changes.

When finished, click on the OK button to confirm the changes. If you want to discard the changes click 
on the Cancel button.

Note:
· The changes only apply to 3D-Win and are not transferred to AutoCAD.

Figure 5        Switch layer dialog box



Walk dialog box

Use this dialog box (available from the Walk command) to define a Walk around or through your object.
The walk will become your current animation, which you can
· replay using the Play command, 
· save to disk using the Save command, or 
· use to create an AVI file with the Save as AVI command.

Figure 6 shows the dialog box which contains the following sections:

· Name
First you must name your Walk. Enter a name or select a previously defined Walk from the drop-
down list. 

· Parameters
· Steps

Determines the number of frames in the animation. This value is set by 3D-Win when you have 
defined the Camera polyline. You can decrease this value later.

· Steps per arc
Using arc segments within 2D polylines (don’t use arcs directly) are very helpful to get a smooth 
animation. This value determines the number of frames per arc segment. 

· Walk-around/Walk-through
Use the radio buttons to specify whether you want a Walk-around or a Walk-Through for your 
animation. 
For a Walk-Around select a 2D/3D polyline for the camera and a 2D/3D polyline or a point for the 
target. The camera and the target will walk along these polylines, i.e., the camera position of the 
first frame is defined by the first vertex of the camera polyline, the camera position of the second 
frame is defined by the second vertex, and so on; the same applies for the target position and the
target polyline. If your target is a point, the target will remain fixed for the whole animation.
For a Walk-Through select a 2D/3D polyline for the camera. Both camera and target will walk 
along this polyline, i.e., the camera position of the first frame is defined by the first vertex of the 
polyline, the camera position of the second frame is defined by the second vertex, and so on. The 
target position of the first frame is defined by the second vertex of the polyline, the target 
position for the second frame is defined by the third vertex, and so on.

· Set
· Camera

Click this button to select the camera polyline. 3D-Win will automatically switch to AutoCAD where
you must pick a previously drawn polyline (_pline, _3dpoly). This polyline will define the camera 
movement during the animation.

· Target
Click this button to select the target polyline or point. 3D-Win will automatically switch to AutoCAD
where you must pick a previously drawn polyline (_pline, _3dpoly). This polyline or point will 
define the target position(s) during the animation.

Notes:
· The Walk will replace 3D-Win’s current animation; a previously recorded animation will be lost.
· Walk definitions are automatically stored with the document.

{button ,AL(`topic_walk;topic_animation',1,"")}    Related topics



Figure 6        Walk dialog box



About 3D-Win dialog box

This dialog box displays the copyright notice and version number of your copy of 3D-Win and is 
available from the About 3D-Win command.



How to select entities?

Use the left mouse button to select or unselect entities. Bounding boxes around the selected entities 
indicate the current selection set.
· Click on an entity to select it.
· To add an entity to 3D-Win’s selection set or to unselect an entity, click on it while pressing the 

Control key.
· To clear 3D-Win’s selection set, click on the background of the model window, or use the Clear 

Selection command, or press the Esc key.
· To invert 3D-Win’s selection set, click on the background of the model window while pressing the 

Control key, or use the Invert Selection command.
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How to change the view?

To change the 3D view of the model 
· move the mouse with the right mouse button pressed, or 
· use the scroll bars in conjunction with the available modes Camera, Target, Distance, Zoom, Twist 

and Clip.
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How to set a new target point?

Either select an object and use the Set Target command to define the center of this entity as the new 
target point, or ...

1 Use the Clip command to activate the Clip mode.
2 Move the clipping plane to your desired target point.
3 Hold down the Control key and click with right mouse button on the new target point.
4 Move the clipping plane back to the camera (value 1.00).
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How to change material settings?

1 Select an entity and use the Material command to display the Material dialog box.
2 If the selected entity is a block with different materials, click in the Material Preview window to 

select the material which you want to edit.
3 Click on the Diffuse radio button.
4 Choose a color from the color matrix and use the vertical slider on the right side of the color matrix 

to adjust the luminance of the color. Watch the changes in the Material Preview window. You can 
change the view with the mouse (hold down the right mouse button).

5 Click on the Ambient radio button and repeat step 4.
6 If you want a material with shininess, click on the Specular radio button, repeat step 4, adjust the 

size of the highlight with the scroll bar for Shininess. Watch the result in Material Preview window.
7 Click the Add to Library button to add your material to 3D-Win’s material library.
8 Click the OK button.
9 To keep the changes for the next session, save your model using the Save command. Load your 

model with the Open command before using the Get Model command.
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How to create, replay and save animations?

To create an animation
· Use the Record command to start recording an animation.
· Move the mouse with the right button held down to change the view dynamically.
· Use the Pause command to interrupt the recording.
· Move the mouse with right button held down to set a different view.
· Use the Pause command to continue recording.
· Now use the scroll bars and change the view several times.
· Use the Stop command to stop recording. 

You can also create an animation using the Walk command.

To replay an animation
· Use the Play command to replay an animation.
· Press the Esc key to cancel the replay.
· Use the Step Forward command to display the next view of the animation.
· Use the Rewind command to display the first view of the animation.

To save an animation
· Use the Save command to save the animation as a TEACH file. With the Open command you can 

load this animation in a later session.
· Use the Save as AVI to create an AVI file from your animation. Use the Preferences command to set 

the resolution of the AVI file. To replay your AVI file use, for example, Microsoft’s Media Player 
(mplayer.exe).
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How to define a Walk as animation?

Use the Walk command to display the Walk dialog box.

To define a Walk-Around
· Enter a name for the Walk definition.
· Click on the Walk-Around radio button.
· Switch to AutoCAD and insert a 2D or 3D polyline in your drawing to define your camera movement 

for the animation. Use arc segments within a 2D polyline to get a smooth animation.
· Insert a point or a polyline in your drawing to define your target position(s) for the animation.
· Switch back to 3D-Win.
· Enter a value for Steps per Arc if you have used arc segment(s) within your polyline(s).
· Click on the Camera button and select your polyline for the camera.
· Click on the Target button and select your point or polyline for the target.

To define a Walk-Through
· Enter a name for the Walk definition.
· Click on the Walk-Through radio button.
· Switch to AutoCAD and insert a 2D- or 3D-polyline in your drawing to become your camera 

movement for the animation. Use arc segments within a 2D polyline to get a smooth animation. 
· Switch back to 3D-Win.
· Enter a value for Steps per Arc if you have used arc segment(s) within your polyline.
· Click on the Camera button and select your polyline for the camera.

To select a previously defined Walk
· Select a Walk from the drop-down list at the top of the the Walk dialog box.

Click the OK button to confirm the Walk definition, and use the Play command to execute it.
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How to keep the 3D-Win window on top?

Pull down the Control menu (also called System menu) and click on the menu item Always on top. A 
checkmark in front of the menu item indicates that this mode is active.



What is a TEACH file?

The Record command enables you to protocol various actions conducted in the 3D-Win window 
(camera movements) in an editable ASCII file. The TEACH file can be replayed in the 3D-Win window 
using the Play command.

You can easily modify your animation, for example, change the viewing angle, by altering a single 
parameter in the ASCII file - even after the animation has been recorded.

Syntax of the TEACH file

Seven parameters are simultaneously set in order to set up the view:

#_X_Y_Z_Theta_Phi_Distance_Twist

Parameters:
X, Y, Z Target point (X , Y and Z coordinates).
Theta Angle above or below the XY plane (Theta).
Phi Angle in the XY plane relative to the X axis (Phi).
Distance Distance between camera and target point.
Twist Angle of the camera position relative to the X axis

Example of an TEACH file

#_-0.035_2.406_3.714_32.000_172.500_106.000_34.000
#_-0.035_2.406_3.714_32.500_171.500_106.000_33.500
#_-0.035_2.406_3.714_31.500_156.000_106.000_24.500
...
#_-0.035_2.406_3.714_-28.500_147.000_106.000_45.000
#_-0.035_2.406_3.714_-28.500_147.500_106.000_46.000
#_-0.035_2.406_3.714_-30.500_147.500_106.000_49.000
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Scroll bars

Change the view of your model with the scroll bars displayed at the right and bottom edges of the 
model window. Which parameters of the view are set with the scroll bars depends on the active mode.
You may also use the mouse to change the view of the model.
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Status bar

The status bar is displayed at the bottom of the 3D-Win window. To display or hide the status bar, use 
the Status Bar command.

The left area of the status bar displays
· a brief description of menu items when you use the arrow keys to navigate through menus
· a brief description for each toolbar button when the mouse cursor is moved over the button

The right areas of the status bar display the values for various view parameters. Which parameters are
displayed depends on the active mode.
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